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Chapter 1

Introducing the IMS eWay

This document describes how to install and configure the IMS eWay Intelligent Adapter 
(called the IMS eWay throughout this document), as well as how to implement the 
eWay in a typical eGate environment.

This chapter provides a brief overview of operations and components, general features, 
and system requirements of the IMS eWay.

What’s in This Chapter

About Information Management System (IMS) on page 6

About the IMS eWay on page 6

About This Document on page 8

Related Documents on page 10

Sun Microsystems, Inc. Web Site on page 10

Documentation Feedback on page 10

1.1 About Information Management System (IMS)
IBM’s IMS, is a database and transaction management system that provides an interface 
for users to access information in various databases via on-line transactions. The IMS/
TM (Transaction Manager) is a message-based transaction processor, that handles the 
execution of specific business application programs. The IMS/DB (Database) is an 
entirely separate component providing access to the IMS hierarchical database for 
applications running under the IMS/TM, as well as IMS transaction monitor and OS/
390 batch jobs.

1.2 About the IMS eWay
The IMS eWay enables eGate to connect with IBM’s IMS/TM mainframe applications 
through IBM’s IMS Connect. (See Figure 1 on page 7).
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 6 Sun Microsystems, Inc.
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Introducing the IMS eWay What’s New in This Release
Figure 1   IMS eWay and the IMS Environment.

The eWay provides access to the Input and Output Descriptors (MID/MOD) of the IMS 
applications without requiring changes to the application. By capturing the field 
contents before screen formatting, the eWay is not affected by cosmetic changes to the 
application’s screen design.

The eWay includes the IMS Message Format Service (MFS) Wizard conversion utility to 
facilitate the creation of input and output Object Type Definitions (OTDs) from IMS 
MFS files.

The implementation of the IMS eWay is in accordance with IBM’s IMS Connect Guide 
and Reference. These documents describe the OTMA protocol and contain important 
prerequisite information for the configuration IMS Connect on the mainframe.

A sample project for the IMS eWay is included on the installation CD-ROM which 
demonstrates how a non-conversational scenario (simple send/response) is managed.

1.3 What’s New in This Release
This 5.1.2 version release provides general maintenance fixes for the IMS eWay 
Intelligent Adapter. The IMS eWay also includes the following changes and new 
features:

New for Version 5.1.0

Version Control: An enhanced version control system allows you to effectively 
manage changes to the eWay components.

Multiple Drag-and-Drop Component Mapping from the Deployment Editor: The 
Deployment Editor now allows you to select multiple components from the Editor's 
component pane, and drop them into your Environment component.

Manual setting for IMS Connection Mode: Allows you to explicitly call the 
connect and disconnect methods in their collaboration as business rules.

Dynamic Generation of IMS Client ID: This parallel mode allows the IMS eWay to 
be configured to handle multiple requests simultaneously.
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Support for Runtime LDAP Configuration: Configuration properties now support 
LDAP key values.

Connection Pooling: Connections can be reused to reduce the overhead of creating 
a physical connection.

Connection Retry Support: Allows you to specify the number of attempts to 
reconnect, and the interval between retry attempts, in the event of a connection 
failure.

Wait Timeout: A new Serial Mode parameter (part of the Environment Explorer 
properties) controls how long, in milliseconds, a request thread will wait for a 
request lock.

Relaunchable OTD Support: An OTD can be rebuilt and saved (under the same 
name) then relaunched back to the same Java Collaboration or BPEL. This allows 
you to change the metadata in an OTD without having to completely recreate the 
business logic from scratch.

Connectivity Map Generator: Generates and links your Project's Connectivity Map 
components using a Collaboration or Business Process.

IRM_TIMER Parameter: Enhanced to provide additional flexibility, allowing the 
user to specify values ranging from .01 secs to 70 minutes.

Support for IMS Connect 9.1

Many of these features are documented further in the Sun SeeBeyond eGate Integrator 
User’s Guide or the Sun SeeBeyond eGate Integrator System Administrator Guide.

1.4 About This Document
This section provides a brief outline of the IMS eWay User’s Guide.

1.4.1 What’s in This Document
This book includes the following chapters:

Chapter 1 “Introducing the IMS eWay” provides an overview of the IMS eWay 
Intelligent Adapter, including a brief description of the IMS. In addition, this 
chapter provides a brief outline of the eWay user’s guide. 

Chapter 2 “Installing the IMS eWay” lists both the supported operating systems 
and system requirements for the IMS eWay. It also includes directions for installing 
the IMS eWay as well as the IMS eWay documentation and sample projects.

Chapter 3 “Configuring the IMS eWay” describes the process of configuring the 
IMS eWay to run in your environment.

Chapter 4 “Using the IMS eWay With eInsight” describes how to use the IMS 
eWay with the Sun Java Composite Application Platform Suite’s eInsight Business 
Process Manager and the Web Services interface. Provides directions for importing 
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 8 Sun Microsystems, Inc.
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and running the eInsight sample project and step by step directions for creating the 
sample project manually.

Chapter 5 “Implementing an IMS eWay Project” describes the features and 
functionality of the IMS eWay using the eGate Integrator and the Collaboration 
Editor (Java). It also provides directions for importing and running the JCS and 
MFS sample projects and step by step directions for creating the sample projects 
manually.

1.4.2 Scope
This user’s guide provides a description of the IMS eWay Intelligent Adapter. It 
includes directions for installing the eWay, configuring the eWay properties, and 
implementing the eWay’s sample projects. This document is also intended as a 
reference guide, listing available properties, functions, and considerations. For a 
reference of available IMS eWay Java methods, see the associated Javadoc.

1.4.3 Intended Audience
This guide is intended for experienced computer users who have the responsibility of 
helping to set up and maintain a fully functioning ICAN Suite system. This person 
must also understand any operating systems on which the ICAN Suite will be installed 
(Windows or UNIX), and must be thoroughly familiar with Windows-style GUI 
operations.

1.4.4 Text Conventions
The following conventions are observed throughout this document.

1.4.5 Screenshots
Depending on what products you have installed, and how they are configured, the 
screenshots in this document may differ from what you see on your system.

Table 1   Text Conventions

Text Convention Used For Examples

Bold Names of buttons, files, icons, 
parameters, variables, methods, 
menus, and objects

Click OK.
On the File menu, click Exit.
Select the eGate.sar file.

Monospaced Command line arguments, code 
samples; variables are shown in 
bold italic

java -jar filename.jar

Blue bold Hypertext links within 
document

See Text Conventions on page 9

Blue underlined Hypertext links for Web 
addresses (URLs) or email 
addresses

http://www.sun.com
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 9 Sun Microsystems, Inc.

http://www.sun.com


Chapter 1 Section 1.5
Introducing the IMS eWay Related Documents
1.5 Related Documents
The following Sun documents provide additional information about the Sun Java 
Composite Application Platform Suite:

eGate Integrator User’s Guide

Sun Java Composite Application Platform Suite Installation Guide

1.6 Sun Microsystems, Inc. Web Site
The Sun Microsystems web site is your best source for up-to-the-minute product news 
and technical support information. The site’s URL is:

http://www.sun.com

1.7 Documentation Feedback
We appreciate your feedback. Please send any comments or suggestions regarding this 
document to:

CAPS_docsfeedback@sun.com
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Chapter 2

Installing the IMS eWay

This chapter explains the procedures for installing the IMS eWay.

What’s in This Chapter

Before You Install on page 10

Installing the IMS eWay on page 10

After Installation on page 12

Extracting the Sample Projects and Javadocs on page 12

ICAN 5.0 Project Migration Procedures on page 12

Installing Enterprise Manager eWay Plug-Ins on page 14

2.1 Before You Install
Open and review the Readme.txt file for the Oracle eWay for any additional 
information or requirements, prior to installation. The Readme.txt file is located on the 
installation CD-ROM.

2.2 Installing the IMS eWay 
The Enterprise Manager, a web-based application, is used to select and upload eWays 
and add-on files during the installation process. The following section describes how to 
install the components required for this eWay.

Refer to the readme for the latest information on:

Supported Operating Systems

System Requirements

External System Requirements

Note: When the Repository is running on a UNIX operating system, the eWays are loaded 
from the Enterprise Manager running on a Windows platform connected to the 
Repository server using Internet Explorer.
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 10 Sun Microsystems, Inc.
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2.2.1 Installing the IMS eWay on an eGate Supported System
After you have installed Core Products, do the following:

1 From the Sun Java Composite Application Platform Suite Installer, click on the 
Click to install additional products link (on the Administration tab). 

2 Expand the eWay option. 

3 From Select Sun Java Composite Application Platform Suite Products to Install, 
select the products for your Sun Java Composite Application Platform Suite and 
include the following:

IMSeWay.sar (to install the IMS eWay)

MFS.sar (to install the MFS Wizard)

FileeWay.sar (to install the File eWay, used with the sample project)

4 Once you have selected all of your products, click Next in the top-right or bottom-
right corner of the Select Sun Java Composite Application Platform Suite 
Products to Install box.

5 From the Selecting Files to Install box, locate and select your first product’s SAR 
file. Once you have selected the SAR file, click Next. Follow this procedure for each 
of your products. The Installing Files window appears after the last SAR file has 
been selected.

6 From the Installing Files window, review the product list. If it is correct, Click 
Install Products. The Enterprise Manager starts the installation.

7 When your product’s installation is completed, click on the prompt, “When 
installation completes, click here to continue.”

To upload the Sun SeeBeyond eWay™ Adapter for IMS User’s Guide, Help file, 
Javadoc, Readme, and sample Projects, do the following:

A Expand the Documentation option.

B Select IMSeWayDocs.

C Click Next in the top-right or bottom-right corner of the Select Sun Java 
Composite Application Platform Suite Products to Install box.

2.2.2 Adding the eWay to an Existing Sun Java Composite 
Application Platform Suite Installation

It is possible to add the eWay to an existing Sun Java Composite Application Platform 
Suite installation.

Steps required to add an eWay to an Existing CAPS installation include:

1 Complete steps 1 through 6 on Installing the IMS eWay on an eGate Supported 
System on page 11.

2 Open the Enterprise Designer and select Update Center from the Tools menu. The 
Update Center Wizard appears.
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 11 Sun Microsystems, Inc.
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3 For Step 1 of the wizard, simply click Next.

4 For Step 2 of the wizard, click the Add All button to move all installable files to the 
Include in Install field, then click Next.

5 For Step 3 of the wizard, wait for the modules to download, then click Next.

6 The wizard’s Step 4 window displays the installed modules. Review the installed 
modules and click Finish.

7 When prompted, restart the IDE (Integrated Development Environment) to 
complete the installation. 

2.3 After Installation
Once the eWay is installed and configured it must then be incorporated into a project 
before it can perform its intended functions. See the eGate Integrator User’s Guide for 
more information on incorporating the eWay into an eGate project.

2.4 Extracting the Sample Projects and Javadocs
The IMS eWay includes sample Projects and Javadocs. The sample Projects are 
designed to provide you with a basic understanding of how certain database 
operations are performed using the eWay, while Javadocs provide a list of classes and 
methods exposed in the eWay.

Steps to extract the Sample Projects and Javadocs include:

1 From the Documentation tab of the Enterprise Manager, click IMS to view the list of 
files available for this product.

2 Click Download Sample to open the IMS_eWay_Sample.zip file.

3 Use WinZip to extract the sample files to a desired location. Note that the 
IMS_eWay_Sample.zip file contains two additional ZIP files for each sample 
Project.

4 Click Download Javadocs to open the IMS_eWay_Javadoc.zip file.

5 Use WinZip to extract the Javadocs files to a desired location.

Refer to Importing a Sample Project on page 46 for instructions on importing the 
sample Project into your repository via the Enterprise Designer.
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 12 Sun Microsystems, Inc.
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2.5 ICAN 5.0 Project Migration Procedures
This section describes how to transfer your current ICAN 5.0 Projects to the Sun Java 
Composite Application Platform Suite 5.1.2. To migrate your ICAN 5.0 Projects to the 
Sun Java Composite Application Platform Suite 5.1.2, do the following:

Export the Project

1 Before you export your Projects, save your current ICAN 5.0 Projects to your 
Repository. 

2 From the Project Explorer, right-click your Project and select Export from the 
shortcut menu. The Export Manager appears.

3 Select the Project that you want to export in the left pane of the Export Manager and 
move it to the Selected Projects field by clicking the Add to Select Items (arrow) 
button, or click All to include all of your Projects.

4 In the same manner, select the Environment that you want to export in the left pane 
of the Export Manager and move it to the Selected Environments field by clicking 
the Add to Select Items (arrow) button, or click All to include all of your 
Environments.

5 Browse to select a destination for your Project ZIP file and enter a name for your 
Project in the ZIP file field.

6 Click Export to create the Project ZIP file in the selected destination.

Install Sun Java Composite Application Platform Suite 5.1.2

1 Install the Sun Java Composite Application Platform Suite, including all eWays, 
libraries, and other components used by your ICAN 5.0 Projects. 

2 Start the Composite Application Platform Suite 5.1.2 Enterprise Designer. 

Import the Project 

1 From the Composite Application Platform Suite 5.1.2 Enterprise Designer’s Project 
Explorer tree, right-click the Repository and select Import Project from the shortcut 
menu. The Import Manager appears.

2 Browse to and select your exported Project file. 

3 Click Import. A warning message, “Missing APIs from Target Repository,” may 
appear at this time. This occurs because various product APIs were installed on the 
ICAN 5.0 Repository when the Project was created, that are not installed on the 
Composite Application Platform Suite 5.1.2 Repository. These APIs may or may not 
apply to your Projects. You can ignore this message if you have already installed all 
of the components that correspond to your Projects. Click Continue to resume the 
Project import.

4 Close the Import Manager after the Project is successfully imported.

Deploy the Project

1 A new Deployment Profile must be created for each of your imported Projects. 
When a Project is exported, the Project’s components are automatically “checked in” 
to Version Control to write-protected each component. These protected components 
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 13 Sun Microsystems, Inc.



Chapter 2 Section 2.6
Installing the IMS eWay Installing Enterprise Manager eWay Plug-Ins
appear in the Explorer tree with a red padlock in the bottom-left corner of each icon. 
Before you can deploy the imported Project, the Project’s components must first be 
“checked out” of Version Control from both the Project Explorer and the 
Environment Explorer. To “check out” all of the Project’s components, do the 
following:

A From the Project Explorer, right-click the Project and select Version Control > 
Check Out from the shortcut menu. The Version Control - Check Out dialog box 
appears.

B Select Recurse Project to specify all components, and click OK. 

C Select the Environment Explorer tab, and from the Environment Explorer, right-
click the Project’s Environment and select Version Control > Check Out from 
the shortcut menu.

D Select Recurse Environment to specify all components, and click OK.

2 If your imported Project includes File eWay External Systems in the Environment, 
the Project’s Environment must be reconfigured prior to deploying the Project. To 
reconfigure your Environment, do the following:

A The properties file for the File External System now includes both inbound and 
outbound properties. If your Environment includes both inbound and outbound 
File External Systems, these can now be combined. Delete all but one of the File 
External Systems.

B From the Environment Explorer tree, right-click your remaining File External 
System, and select Properties from the shortcut menu. The Properties Editor 
appears.

C Set the inbound and outbound directory values, and click OK.

3 Deploy your Projects.

2.6 Installing Enterprise Manager eWay Plug-Ins
The Sun SeeBeyond Enterprise Manager is a Web-based interface that allows you to 
monitor and manage your Composite Application Platform Suite applications. The 
Enterprise Manager requires an eWay specific “plug-in” for each different eWay you 
install. These plug-ins enable the Enterprise Manager to target specific alert codes for 
each eWay type, as well as to start and stop the inbound eWays. 

The Sun Java Composite Application Platform Suite Installation Guide describes how to 
install Enterprise Manager. The Sun SeeBeyond eGate Integrator System Administration 
Guide describes how to monitor servers, Services, logs, and alerts using the Enterprise 
Manager and the command-line client. 

The eWay Enterprise Manager plug-ins are available from the List of Components to 
Download under the Sun Java Composite Application Platform Suite Installer’s 
DOWNLOADS tab. 

There are two ways to add the eWay Enterprise Manager plug-ins:
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 14 Sun Microsystems, Inc.
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From the Sun SeeBeyond Enterprise Manager

From the Sun Java Composite Application Platform Suite Installer

To add plug-ins from the Enterprise Manager

1 From the Enterprise Manager’s Explorer toolbar, click configuration. 

2 Click the Web Applications Manager tab, go to the Auto-Install from Repository 
tab, and connect to your Repository.

3 Select the application plug-ins you require, and click Install. The application plug-
ins are installed and deployed.

To add plug-ins from the Sun Java Composite Application Platform Suite Installer

1 From the Sun Java Composite Application Platform Suite Installer’s Download 
tab, select the Plug-Ins you require and save them to a temporary directory. 

2 From the Enterprise Manager’s Explorer toolbar, click configuration.

3 Click the Web Applications Manager tab and go to the Manage Applications sub-
tab.

4 Browse for and select the WAR file for the application plug-in that you 
downloaded, and click Deploy. The plug-in is installed and deployed.

Viewing Alert Codes

You can view and delete alerts using the Enterprise Manager. An alert is triggered 
when a specified condition occurs in a Project component. The purpose of the alert is to 
warn the administrator or user that a condition has occurred. 

To View the eWay Alert Codes

1 Add the eWay Enterprise Manager plug-in for this eWay.

2 From the Enterprise Manager’s Explorer toolbar, click configuration.

3 Click the Web Applications Manager tab and go to the Manage Alert Codes tab.

4 Browse for and select the Alert Properties File for the application plug-in that you 
added. The Alert Properties Files are located in the alertcodes folder of your Sun 
Java Composite Application Platform Suite installation directory.

5 Click Deploy. The available alert codes for your application are displayed under 
Results. A listing of available alert codes is displayed in Table 2.

Table 2   IMS eWay Alert Codes

Alert Code Description User Action

IMSCLIENTEWAY-CONNECT 
-FAILED000002

Failed to connect to IMS. IMS is down. Verify that the system 
you are connecting to is running.
Properties are incorrect. Verify that 
your parameters are correct (host 
name, port, and so forth).
CTG configuration is incorrect. 
Verify CTG installation and 
configuration is correct.
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 15 Sun Microsystems, Inc.
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For information on Managing and Monitoring alert codes and logs, see the Sun 
SeeBeyond eGate Integrator System Administration Guide.
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 16 Sun Microsystems, Inc.
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Configuring the IMS eWay

This chapter describes how to configure the IMS eWay properties, and provides a list of 
the eWay properties and their required values.

What’s in This Chapter

Creating and Configuring the IMS eWay on page 17

IMS eWay Connectivity Map Properties on page 20

IMS eWay Environment Explorer Properties on page 21

3.1 Creating and Configuring the IMS eWay
All eWays contain a set of parameters with properties that are unique to that eWay type. 
The IMS eWay properties are modified from these locations:

Connectivity Map: These parameters most commonly apply to a specific 
component eWay, and may vary from other eWays (of the same type) in the Project.

Environment Explorer: These parameters are commonly global, applying to all 
eWays (of the same type) in the Project. The saved properties are shared by all 
eWays in the IMS External System window.

Collaboration or Business Process: IMS eWay properties may also be set from your 
Collaboration or Business process, in which case the settings will override the 
corresponding properties in the eWay’s configuration file. Any properties that are 
not overridden retain their configured default settings.

3.1.1 Selecting IMS as the External Application
To create an IMS eWay you must first create an IMS External Application in your 
Connectivity Map. IMS eWays are located between an IMS External Application and a 
Service. Services are containers for Java Collaborations, Business Processes, eTL 
processes, and so forth.

To create the IMS External Application

1 From the Connectivity Map toolbar, click the External Applications icon. 

2 Select the IMS External Application from the menu (see Figure 2 on page 18). The 
selected IMS External Application icon appears on the Connectivity Map toolbar.
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Figure 2   External Applications Selection Menu

3 Drag the new IMS External Application from the toolbar onto the Connectivity 
Map canvas. This icon now represents an external IMS system.

From the Connectivity Map, you can associate (bind) the External Application to 
the Service to establish an eWay (see Figure 3).

Figure 3   eWay Location. 

When IMS is selected as the External Application, it automatically applies the default 
IMS eWay properties, provided by the OTD, to the eWay that connects it with the 
Service. These properties can then be or modified for your specific system using the 
Properties Editor.

3.1.2 Configuring the IMS eWay Properties
A Project’s eWay properties can be modified after the eWay has been established in the 
Connectivity Map and the Environment has been created.

Configuring the IMS eWay (Connectivity Map) Properties

1 From the Connectivity Map, double click the eWay icon located in the link between 
the associated External Application and the Service. 

2 The eWay Properties Editor appears with a template containing the IMS eWay 
Connectivity Map properties. Make any necessary changes to the property values 
and click OK to save the settings.

Configuring the IMS eWay (Environment Explorer) Properties

1 From the Environment Explorer tree, right-click the IMS External System. Select 
Properties from the shortcut menu. The Properties Editor opens with the IMS eWay 
Environment properties.

2 Make any necessary changes to the Environment property values, and click OK to 
save the settings.
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3.1.3 Using the Properties Editor 
Modifications to the eWay properties are made using the IMS eWay Properties Editor. 

A description of each property is displayed in the Description pane when that property 
is selected. This provides a brief explanation of the required settings or options.

The Comments pane provides an area to record notes and information regarding the 
currently selected property. These comments are saved when you close the editor.

After modifying the configuration properties, click OK to close the Properties Editor 
and save your changes.

Modifying the Default eWay Properties

1 From the Connectivity Map or the Environment Explorer, open the Properties 
Editor to the IMS eWay default properties. 

2 From the upper-right pane of the Properties Editor, select a subdirectory of the 
configuration directory. The parameters contained in that subdirectory are now 
displayed in the Properties pane of the Properties Editor. For example, if you click 
on the connector subdirectory, the editable connector parameters are displayed in 
the right pane (see Figure 4).

Figure 4   Properties Editor -- IMS eWay Properties

3 Click on any property field to make it editable. For example, click on the class 
property to edit the class value. If a property value is true/false or multiple choice, 
the field displays a submenu of property options. 

4 Click on the ellipsis (...) in the properties field to open a separate configuration 
dialog box. This is helpful for large values that cannot be fully displayed in the 
parameter’s property field. Enter the property value in the dialog box and click OK. 
The value is now displayed in the property field.
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3.2 IMS eWay Connectivity Map Properties
The IMS eWay configuration parameters, accessed from the Connectivity Map, are 
organized into the following sections:

Outbound Connectivity Map Properties on page 20

3.2.1 Outbound Connectivity Map Properties
The Outbound configuration parameters, accessed from the Connectivity Map, are 
organized into the following sections:

Connector on page 20

Connection Mode on page 20

Connector

The Connector section contains the top level parameters contained in Table 3.

Connection Mode

The Connection Mode section contains the top level parameters contained in Table 4.

Table 3   IMS eWay connector Parameter Settings

Name Description Required Value

Type Specifies the connector type. IMSClientETD by default for 
IMSClientETD connections.

Class Specifies the class name of the ETD 
connector object.

A valid package name. The 
default is 
com.stc.eways.ims.IMSClient
ETDConnector.
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3.3 IMS eWay Environment Explorer Properties
The IMS eWay configuration parameters, accessed from the Environment Explorer tree, 
are organized into the following sections:

TCPIP Configuration on page 22

IRM Header on page 22

Connection Retry Settings on page 30

Connection Pool Settings on page 31

Table 4   IMS eWay Connection Mode Parameter Settings

Name Description Required Value

IMS Connection 
Mode

Specifies how a connection with the 
external system is established and closed.  

Automatic indicates that the connection 
is automatically established when the 
collaboration is started, and it keeps the 
connection alive as needed. 
OnDemand indicates that the 
connection will be established on 
demand, as business rules requiring a 
connection to the external system are 
performed.  The connection will be 
closed after the methods are 
completed.  
Manual indicates that the user will 
explicitly call the connect and 
disconnect connection methods in 
their collaboration as business rules.  
Default is Automatic.

Either a Manual or Automatic 
setting. Default setting is 
Manual.
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Figure 5   IMS eWay Environment Properties Editor

3.3.1 TCPIP Configuration
The TCPIP Configuration section contains information for connecting to the Portal 
Infranet. This section contains the top level parameters, as displayed in Table 5.

3.3.2 IRM Header
The IRM (IMS Request Message) Header section contains the top level parameters: 
displayed in Table 6.

Note: For a full description of the IRM header, see IBM's IMS Connect Guide and 
Reference (SC27-0946-00).

Table 5   Environment TCPIP Configuration Settings

Name Description Required Value

Server Specifies the name of the server host. This 
parameter is mandatory.

The server host name.

Port Specifies the port that IMS Connect is 
listening on. This parameter is mandatory.

A number indicating the port 
on which IMS Connect is 
listening. The default is 7777.
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Table 6   Environment IRM Header Settings

Name Description Required Value

IRM_LEN Specifies the length of the IRM structure. 
The user written exits minimum size is 36. 
HWSIMSO0 and HWSSMPL1 have a 
minimum IRM length of 80.

An integer indicating valid 
IRM structure length. The 
configured default is 80.

IRM_ID Specifies the identifier (character string) 
of the user exit that is driven after the 
complete message is received. 
In a program, an exit is used to move from 
the called routine back to the calling 
routine. A routine can have more than 
one exit point, thus allowing termination 
based on various conditions.

The following IDs are used by the IMS 
Connect-supplied user message exits:

*IRMREQ* (for HWSIMSO0)
*SAMPL1* (for HWSSMPL1)

The appropriate identifier 
character string. The 
configured default is 
*SAMPL1*.

IRM_TIMER Specifies the time delay for the receive to 
the Datastore after an ACK or RESUME 
TPIPE. One of following three predefined 
timer options can be selected:

.25 SEC: .25 seconds. 
No_Wait: Timer is not set and no delay 
occurs.
Block: The receive waits indefinitely. 
This setting is used to support the Auto 
option of the asynchronous output 
function.

OR

One of the following hex values can be 
entered as a timer value:

X01 - X19: Range from 0.01 to 0.25 
second, 0.01 second increments.
X19 - X28: Range from 0.25 to 1 second, 
0.05 second increments.
X28 - X63: Range from 1 to 60 second, 1 
second increments.
X63 - X9E: Range from 1 to 70 minutes, 1 
minute increments.

Select one of the three 
predefined options or enter a 
valid hex value. The 
configured default is .25 SEC.

Note: The following hex 
values correspond to the 
three predefined choices in 
the drop-down menu: 

X00 = Default - .25 secs
XE9 = No_Wait - does not 
set the timer 
XFF = Block
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IRM_SOCT Specifies the socket connection type.
Transaction: Transaction socket. The 
socket connection lasts across a single 
transaction.
Persistent: Persistent socket. The socket 
connection lasts across multiple 
transactions.
Non_Persistent: Non-persistent socket. 
The socket connection lasts for a single 
exchange consisting of one input and 
one output. Do not use Non_Persistent 
when implementing conversational 
transactions because this type causes 
multiple connects and disconnects.

Select one of the three 
options. The configured 
default is Persistent.

Note: The default for 
this property was 
changed from the 
previous version.

IRM_CLIENTID Specifies the name of the client ID 
(character string) to be used by IMS 
Connect. For more information on 
configuring Client IDs refer to 
Configuring the Client ID for the IMS 
eWay on page 29

IMS eWay supports both Serial and 
Parallel mode. Serial mode is supported 
by specifying a ClientID, while Parallel 
mode is supported by specifying a 
ClientID with an *. 

Important: In each deployment, 
the ClientID must be unique. 

The client ID to be used by 
IMS Connect. 

IRM_F1 (MFS MOD 
Names)

Specifies whether the MFS Message 
Output Descriptor (MOD) is returned as 
part of the output.
MFS: The user requests that MFS MOD 
name be returned.
NO_MFS: The user requests that no MFS 
MOD name be returned. 
When MFS is specified, a Request Mod 
Message (RMM) is returned as the first 
structure of the output message. This 
structure contains an ID of *REQMOD* 
followed by the MFS MOD name. For 
details, see IBM's IMS Connect Guide and 
Reference, (SC27-0946-00), page 59.

MFS or NO_MFS. The default 
is NO_MFS.

Table 6   Environment IRM Header Settings

Name Description Required Value
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IRM_F2 (COMMIT 
MODE)

Specifies the Commit Mode. 
COMMIT_MODE_0 - Also known as 
commit-then-send.
COMMIT_MODE_1 - Also known as 
send-then-commit.

For a full description of the IRM header, 
see IBM's IMS Connect Guide and 
Reference (SC27-0946-00).

COMMIT_MODE_0 or 
COMMIT_MODE_1. The 
default is COMMIT_MODE_1.

Note: The default for 
this property was 
changed from the 
previous version.

IRM_F3 (Sync Level) Specifies whether the message is to be 
confirmed with an ACK for Commit Mode 
1 processing. For Commit Mode 0, IRM_F3 
must be set to SYNC_LEVEL_CONFIRM.

SYNC_LEVEL_CONFIRM: Must be used 
when the IRM_F2 parameter (commit 
mode) is set to COMMIT_MODE_0.
SYNC_LEVEL_NONE: No Sync level.

SYNC_LEVEL_CONFIRM or 
SYNC_LEVEL_NONE. If the 
IRM_F2 property is set to 
COMMIT_MODE_0, the Sync 
level must be set to 
SYNC_LEVEL_CONFIRM. The 
default is 
SYNC_LEVEL_NONE.

Note: The default for 
this property was 
changed from the 
previous version.

Table 6   Environment IRM Header Settings

Name Description Required Value
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 25 Sun Microsystems, Inc.



Chapter 3 Section 3.3
Configuring the IMS eWay IMS eWay Environment Explorer Properties
IRM_F4 (ACK/NAK/ 
Response)

Specifies the ACK/NAK (positive/negative 
acknowledgement) response expression 
sent to IMS Connect and forwarded to 
IMS. The ACK/NAK/DEALLOCATE /
RESUME [A/N/D/R] values must be sent to 
IMS Connect with no data element.

NO_ACK: No request for 
acknowledgment or deallocation. 
When a response mode transaction or 
conversational transaction is being sent 
to IMS Connect, IRM_F4 must be set to 
NO_ACK.
ACK: Positive acknowledgment, used in 
response to a message sent to the client 
where the SYNC level is set to 
CONFIRM (SYNC _LEVEL_CONFIRM). 
DEALLOCATE: Deallocate connection. 
Used to terminate a conversation 
before the conversation is complete.
NACK: Negative acknowledgment. 
Used in response to a message sent to 
the client where the SYNC level is set to 
CONFIRM (SYNC _LEVEL_CONFIRM).
RESUME: Resume TPIPE. Used to 
request Asynchronous output data 
from IMS. Resume must execute on a 
transaction socket as 
COMMIT_MODE_0.
SENDONLY: Send only, used for a non-
response transaction and for sending 
data to IMS. SENDONLY must execute 
as COMMIT_MODE_0.

Select one of the six options. 
The configured default is 
NO_ACK.

Table 6   Environment IRM Header Settings

Name Description Required Value
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IRM_F5 (Flow 
Control)

Specifies Flow Control properties.
Sun recommends using the default value 
No_Auto_Flow. 

Note: Contact Sun Support before using 
any value other than No_Auto_Flow. 

Client_Translation: Translation is done 
by the client.
Single_Message: Returns only one 
message on receive following the 
resume TPIPE.
No_Auto_Flow: No message auto flow 
(see meaning for No_Auto_Flow_Out).
Auto_Flow_Out: Auto message flow. 
Returns all current messages, one at a 
time, and waits on the last receive for 
the next message for IRM_TIMER value. 
Set the IRM_TIMER high. Use this only 
for a dedicated output client.
No_Auto_Flow_Out: No message auto 
flow. Returns all current messages one 
at a time, and waits on the last receive 
for the next message for IRM_TIMER 
value. Set the IRM_TIMER low. Use this 
only for a dedicated output client. This 
value is similar to Auto_Flow_Out, as 
described above, except that the 
IRM_TIMER causes the last receive to 
terminate.

The recommended setting is 
No_Auto_Flow (default).

IRM_TRNCOD Specifies the default IMS transaction 
code.

A valid transaction code.

IRM_TRNCOD_SRC Specifies where the transaction code is 
taken. 

CFG: The transaction code is to be 
taken from the configuration file.
MESSAGE: the transaction code is the 
first 8 bytes of the message.

Select one of the two options. 
The configured default is 
CFG.

IRM_DESTID Specifies the Datastore name (IMS 
destination ID). This field is required.

String-set. A Datastore name/
IMS destination ID (character 
string).

IRM_LTERM Specifies the IMS LTERM override name. 
This field can be set to a name or blank.

The appropriate LTERM name 
or blank. 

IRM_RACF_GRNAM
E

Specifies the RACF Group Name. The 
client must provide the RACF group name 
if RACF is to be used. 

The appropriate RACF group 
name.

Table 6   Environment IRM Header Settings

Name Description Required Value
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IRM_RACF_USERID Specifies the RACF User ID. The client 
must provide the RACF user ID if RACF is 
used. 

A valid RACF user ID.

IRM_RACF_PW Specifies the RACF PASSTICKET. The 
client must provide the RACF PASSTICKET 
if RACF is to be used. 

The appropriate RACF 
PASSTICKET.

IRM_HEADER_ENCO
DING

Specifies the encoding of the IRM Header 
properties sent to IMS Connect. 

Set the value to ISO-8859-1 if the 
message body is ASCII text. The IMS 
Connect *SAMPL1* user exit converts 
the data to EBCDIC.
Set the value to an EBCDIC code set, 
such as cp500, if the message is EBCDIC 
text or binary data. No data translation 
occurs.

ISO-8859-1 for ASCII 
transaction content, or an 
EBCDIC code, such as cp500, 
for EBCDIC transaction 
content.

SEND_DATA_ENCO
DING

Specifies the encoding translation (if any) 
to apply to the message body sent to IMS 
Connect.

Set to NO TRANSLATION to send the 
message body to IMS Connect without 
translation, or when using the 
*SAMPL1* user exit when the IRM 
Headers and message body are in 
ASCII.
Set to an EBCDIC code, such as cp500, 
to translate the message body from 
ASCII to EBCDIC before sending to IMS 
Connect.
If the content is a double-byte character 
set such as Japanese, set to the EBCDIC 
code page for that language (for 
example, cp930 for Japanese).

Enter NO TRANSLATION or 
the appropriate code page as 
follows:

Enter NO TRANSLATION 
when using the *SAMPL1* 
user exit and IRM Headers 
and message content is in 
ASCII. 
Enter an EBCDIC code, such 
as cp500, to translate ASCII 
message content to EBCDIC 
before sending it to IMS 
Connect. 
For double-byte character 
sets, enter the appropriate 
code page for that language 
(for example, cp390 for 
Japanese).

REPLY_DATA_ENCO
DING

Specifies the encoding of the message 
body received back from IMS Connect.
Set to ISO-8859-1 if the message text is 
ASCII. 

Set to an EBCDIC code, such as cp500, if 
the return message is EBCDIC and/or 
no content translation is needed.
If the content set is a double-byte 
character, such as Japanese, set the 
appropriate EBCDIC code page for that 
language (for example, cp930 for 
Japanese).

The appropriate code page:
For ASCII transactions, enter 
ISO-8859-1.

For EBCDIC transactions, 
enter an EBCDIC code, such 
as cp500.
For double-byte character 
sets, enter the appropriate 
code page for that language 
(for example, cp390 for 
Japanese).

Table 6   Environment IRM Header Settings

Name Description Required Value
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Configuring the Client ID for the IMS eWay

The following sections describe the configuration of Client IDs for the IMS eWay.

Dynamic Generation of IMS Client ID

In this mode, the IMS eWay is configured to handle multiple requests simultaneously 
(parallel mode). To configure the IMS eway for parallel processing, do the following:

1 Set the Client ID in the IRM_Header section to a string which contains one or more 
trailing asterisks; for example, “SUN*”.

The eWay will generate the rest of the Client ID string filling it with randomly 
generated alphanumeric characters. The length of the Client ID is 8. If you use a 
static Client ID, it must be unique (across deployments) if the IMS external systems 
which are being used are configured to connect to the same IMS Connect.

2 Set the IRM_SOCT in the IRM_Header section to Persistent.  

This allows the eway to retain the physical connection so that it can leverage the use 
of connection pooling as a resource adapter. If this is not set to Persistent and the 
Client ID is configured to use dynamic generation (i.e., with an “*”), then a protocol 
error will occur.

No other IRM_SOCT type can be used in parallel mode; as noted a protocol error 
will result if Persistent is not used.

For the acknowledgement response expression (IRM_F4 - ACK/NAK Response), the 
following additonal parameters must be set (in addition to the above):

1 Set the IRM_F2 (commit mode) to COMMIT_MODE_0.

2 Set the IRM_F3 (sync level) to SYNC_LEVEL_CONFIRM.

Static IMS Client ID

In this mode, the IMS eWay is configured to handle one single request at a time. 
Multiple requests are serialized by the IMS eWay through an internal locking 
mechanism. To configure the IMS eway for serialized processing, do the following:

1 Set the Client ID in the IRM_Header section to a string which does NOT contain an 
asterisk; for example, “SUNIMS”.

The eWay will generate the rest of the Client ID string filling it with randomly 
generated alphanumeric characters. The length of the Client ID is 8.  If you use a 
static Client ID, it must be unique (across deployments) if the IMS external systems 
which are being used are configured to connect to the same IMS Connect.

For the acknowledgement response expression (IRM_F4 - ACK/NAK Response), the 
following additional parameters must be set (in addition to the above):

1 Set the IRM_SOCT to Transaction.

2 Set the IRM_F2 (commit mode) to COMMIT_MODE_0.

3 Set the IRM_F3 (sync level) to SYNC_LEVEL_CONFIRM.

Duplicate Client IDs

When sending an IMS Connect interaction on a given port, an error will occur when 
using a ClientID which is already in use on that port. This can happen when you are 
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executing an interaction with a ClientID, which is the same as that used by another 
interaction that ended as a result of a socket timeout. If this new interaction is received 
by IMS Connect while IMS Connect is still waiting for a response from IMS for the 
original interaction that received the socket timeout, a duplicate ClientID error could 
occur.

This can also occur if the socket timeout being used for the original interaction is set to 
a value which is less than the timeout set by the IRM_TIMER or the IMS Connect 
default timeout (set in the HWSCFGxx member). IMS Connect is not aware that the 
original socket has been disconnected as a result of the socket timeout until it does a 
subsequent read on that socket. This means it would consider the original socket still 
active, even though that socket has already been disconnected from the client end. Once 
you get to this situation, you will receive DUPECLNT errors until the IRM_TIMER 
expires on the IMS Connect side.

Note: For a full discussion of Client ID and timer issues, refer to “IMS Connectivity in 
the On Demand Environment - A Practical Guide to IMS Connectivity” 
(IBM Publication SG24-6794-00).

3.3.3 Serial Mode Settings
The Serial Mode Settings section of the Outbound IMS Environment contains the top-
level parameters displayed in Table 8.

3.3.4 Connection Retry Settings
The Connection Retry Settings section of the Outbound IMS Environment contains the 
top-level parameters displayed in Table 8.

Table 7   Outbound IMS eWay Environment - Serial Mode Settings

Name Description Required Value

Wait Timeout When IRM_CLIENTID is static, which 
results in requests being serialized, 
multiple threads using the same Client ID 
will contend for a request lock. Threads 
contending for a request lock, being held 
by another thread, will wait until the 
pending request thread releases the lock. 
This parameter controls how long, in 
milliseconds, a request thread will wait 
for the lock.

An integer indicating the 
configured length of the time 
a thread will wait for the lock. 
The default is 6000 
(milliseconds).

Table 8   Outbound IMS eWay Environment - Connection Retry Settings

Name Description Required Value

Maximum Retries Specifies the number of retries to 
establish a connection with the IMS 
database upon a failure to acquire one.

an integer indicationg the 
number of attempts allowed 
to establish a connection. The 
configured default is 5.
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3.3.5 Connection Pool Settings
The Connection Retry Settings section of the Outbound IMS Environment contains the 
top-level parameters displayed in Table 8.

Retry Interval [ms] Specifies the configured length of the 
pause before each reattempt to access 
the destination file. This property is used 
in conjunction with the property 
Maximum Retries.

An integer indicating the 
configured length of the time 
(in milliseconds) before each 
reattempt to access the 
destination file. The 
configured default is 5000 ( 1 
second).

Table 9   Outbound IMS eWay Environment - Connection Pool Settings

Name Description Required Value

Steady Pool Size Specifies the initial and minimum number 
of connections to be maintained.

A number indicating the 
initial and minimum number 
of connections to be 
maintained. The configured 
default is 2.

MaxPoolSize The maximum number of physical 
connections the pool keeps available at 
all times. 0 (zero) indicates that there is no 
maximum.

A valid numeric value. The 
default is 10.

Table 8   Outbound IMS eWay Environment - Connection Retry Settings

Name Description Required Value
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Chapter 4

Using the IMS eWay With eInsight

This chapter describes how to use the IMS eWay with Sun Java Composite Application 
Platform Suite’s eInsight Business Process Manager and its engine’s Web Services 
interface.

Note: You must have the eInsight.sar file installed to use the Web Services interface.

What’s in This Chapter

eInsight Engine and Components on page 32

The IMS eWay With eInsight on page 33

Steps Required to Run the Sample Projects on page 33

Importing a Sample Project on page 33

The prjIMS_BP_Sample Project on page 34

4.1 eInsight Engine and Components
eGate components can be deployed as Activities in eInsight business processes. Once a 
component is associated with an Activity, eInsight invokes it using a Web Services 
interface. eGate components that can interface with eInsight in this way include:

Object Type Definitions (OTDs)

eWays

Collaborations

Using the Enterprise Designer and eInsight, you can add an Activity to a Business 
Process, then associate that Activity with an eGate component, for example, an eWay. 
Once eInsight runs the Business Process, it automatically invokes that component via 
its Web Services interface. See the eInsight Business Process Manager User’s Guide for 
details.
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4.2 The IMS eWay With eInsight
An eInsight Business Process Activity can be associated with the IMS eWay during the 
system design phase. To make this association, select the desired operators under the 
eWay (in the Enterprise Explore) and drag it onto the eInsight Business Process 
Designer canvas. Currently, the IMS eWay has only the IMSRequest operator available.

The operation is automatically changed to an Activity with an icon identifying the 
component that is the basis for the Activity. At run time, eInsight invokes each step in 
the order defined in the Business Process. Using eInsight’s Web Services interface, the 
Activity, in turn, invokes the IMS eWay. 

4.3 Steps Required to Run the Sample Projects
The following steps are required to run the sample projects that are contained in the 
IMSeWayDocs.sar file.

1 Import the sample Projects. 

2 Build, deploy, and run the sample Projects.

You must do the following before you can run an imported sample Project:

Create an Environment

Configure the eWays

Create a Deployment Profile

Create and start a domain

Deploy the Project

3 Check the output.

4.4 Importing a Sample Project
Sample eWay Projects are included as part of the installation CD-ROM package. To 
import a sample eWay Project to the Enterprise Designer do the following:

1 Extract the samples from the Enterprise Manager to a local file.

Sample files are uploaded with the eWay’s documentation SAR file, and then 
downloaded from the Enterprise Manager’s Documentation tab. The 
IMS_eWay_Sample.zip file contains the various sample Project ZIP files. 

Note: Make sure you save all unsaved work before importing a Project.
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2 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import Project from the shortcut menu. The Import Manager appears.

3 Browse to the directory that contains the sample Project ZIP file. Select the sample 
file and click Import.

Click Close after successfully importing the sample Project. 

4.5 The prjIMS_BP_Sample Project
The prjIMS_BP_Sample project demonstrates connectivity with an external IMS 
system. 

Sample Project Overview

1 The inbound File eWay receives a file from an external directory. 

2 This file is published by the IMS eWay to an external IMS application. 

3 The IMS eWay receives the file back from the external IMS application, and 
publishes the file to the outbound File eWay.

The outbound File eWay publishes the file to an external directory.

4.5.1 Creating a Project
The first step is to create a new project in the Sun Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Enterprise Explorer’s Project Explorer tab, right-click the Repository and 
select New Project (see Figure 6 on page 34). A new project (Project1) appears on 
the Project Explorer tree.

Figure 6   Enterprise Explorer - New Project

3 Click twice (not a double-click) on Project1 and rename the project (for this sample, 
prjIMS_BP_Sample).

4.5.2 Creating a Business Process
To create the IMS eInsight Business Process, do the following:
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Creating the Business Process Flow

1 Right-click the existing project (for this sample prjIMS_BP_Sample) in the Project 
Explorer tree, and select New > Business Process from the shortcut menu. The 
eInsight Business Process Designer appears. Rename the new Business Process 
(BusinessProcess1) to BP1. BP1 will be added to the tree.

2 From the Project Explorer tree, expand both of the following eWays nodes (as 
displayed in Figure 7):

IMSeWay > IMS_eWay 

File > FileClient

3 Populate the eInsight Business Process Designer’s modeling canvas with the 
following activities from the Project Explorer tree (as displayed in Figure 7):

receive, under Sun SeeBeyond> eWays >File > FileClient

IMSRequest, under Sun SeeBeyond> eWays > IMSeWay > IMS_eWay

write, under Sun SeeBeyond> eWays SeeBeyond>File > FileClient

Figure 7   eInsight Business Process Designer - Populate the Canvas

4 Link the modeling elements by clicking on the element’s connector and dragging 
the cursor to the next element’s connector, making the following links as displayed 
in Figure 8.

Start -> FileClient.receive

FileClient.receive -> IMS_eWay.IMSRequest

IMS_eWay.IMSRequest ->FileClient.write

FileClient.write -> End
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Figure 8   eInsight Business Process Designer - Link the Modeling Elements

Configuring the Modeling Elements 

Business Rules, created between the Business Process Activities, allow you to configure 
the relationships between the input and output attributes of the Activities using the 
Business Process Editor’s Business Rules Designer.

Adding Business Rules

1 Right-click the link between the FileClient.receive and IMS_eWay.request 
Activities and select Add Business Rule from the shortcut menu. 

2 Repeat step 1 for the link between IMS_eWay.request and FileClient.write (see 
Figure 9).

Figure 9   eInsight Business Process Designer - Adding Business Rules

Using the Business Rules Designer

1 From the eInsight Business Process Designer toolbar, click the Display Business 
Rules Designer button. The Business Rules Designer appears at the bottom of the 
eInsight Business Process Designer.

2 Click on the Business Rule icon in the link between FileClient.receive and 
IMS_eWay.IMSRequest to display the Business Rule Input and Output Attributes 
in the Business Rules Designer. These attributes can now be modified.
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3 Map text, under FileClient.receive.Output in the Output pane, to message under 
IMS eWay.IMSRequest.Input > input in the Input pane. This is done by clicking on 
text and dragging the cursor to message (see Figure 10).

Figure 10   eInsight Business Rules Designer

4 To configure the second Business Rule, click on the Business Rule in the link 
between the IMS_eWay.IMSRequest and FileClient.write Activities. This Business 
Rule is now displayed in the Business Rules Designer.

5 Map reply, under IMS_eWay.IMSRequest.Output > output in the Output pane of 
the Business Rules Designer, to text, under FileClient.write.Input in the Input pane 
as displayed in Figure 11.

Figure 11   eInsight Business Rules Designer

6 When the Business Process is complete, from the eInsight Business Process 
Designer toolbar, click the Synchronize Graphical Model and Business Process 
Code icon to synchronize the graphical interface to the Business Process code.

7 Save your changes to the Repository.

4.5.3 Creating a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a project’s 
components.

1 From the Project Explorer tree, right-click the new prjIMS_BP_Sample project and 
select New > Connectivity Map from the shortcut menu. 
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2 The New Connectivity Map appears and a node for the Connectivity Map is added 
under the project on the Project Explorer tree labeled CMap1. Rename the 
Connectivity Map cmIMS_BP.

The icons in the toolbar represent the available components used to populate the 
Connectivity Map canvas. 

Selecting the External Applications

In the Connectivity Map, the eWays are associated with External Systems. For example, 
to establish a connection to IMS, you must first select IMS as an External System to use 
in your Connectivity Map (see Figure 12). 

Figure 12   Connectivity Map - External Applications

1 Click the External Application icon on the Connectivity Map toolbar.

2 Select the external systems needed for your project (for this sample, IMS and File). 
Icons representing the selected external systems are added to the Connectivity Map 
toolbar.

Populating the Connectivity Map

Add the project components to the Connectivity Map by dragging the icons from the 
toolbar to the canvas.

1 For this sample, drag the following components onto the Connectivity Map canvas 
as displayed in Figure 13: 

File External System (2)

Service (A service is a container for Java Collaborations, Business Processes, 
eTL processes, and so forth) This can also be created by dragging the Business 
Process over from the Project Explorer tree.

IMS External System
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Figure 13   Connectivity Map with Components

2 Rename the Connectivity Map objects by right-clicking the object’s name, selecting 
Rename from the shortcut menu, and typing the new name. Rename the objects as 
follows: 

File1 to eaFileIn

Service1 to BP_IMS

IMS1 to eaIMS

File2 to eaFileOut

3 Save your changes to the Repository.

4.5.4 Binding the eWay Components
After the Business Processes have been written, the components are associated and 
bindings are created in the Connectivity Map.

1 From the Project Explorer, double-click the Connectivity Map cmIMS_BP. The 
Enterprise Designer canvas now displays the Connectivity Map.

2 Drag and drop the BP1 Business Process from the Project Explorer onto the Service 
(BP_IMS). If the Business Process was successfully associated, the Service’s icon 
changes to a Business Process icon (see Figure 14).
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Figure 14   Connectivity Map - Binding the eWay Components

3 Double-click cmIMS_BP. The BP_IMS_Service Binding dialog box appears using 
the IMS_BP Rule.

4 From the BP_IMS_Service Binding dialog box, drag FileSender (under 
Implemented Services) to the eaFileIn (File) External Application.

5 From the BP_IMS_Service Binding dialog box, drag IMS_Receiver (under Invoked 
Services) to the IMS External Application. 

6 From the BP_IMS_Service Binding dialog box, drag FileReceiver to the eaFileOut 
External Application (see Figure 15). Minimize the BP_IMS_Service Binding dialog 
box by clicking the chevrons in the upper-right corner.

Figure 15   Connectivity Map - Associating (Binding) the Project’s Components

7 Save your current changes to the Repository.

4.5.5 Creating an Environment
Environments include the external systems, Logical Hosts, integration servers, and JMS 
IQ Managers used by a project, and contain the configuration information for these 
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components. Environments are created using the Enterprise Designer’s Environment 
Explorer and Environment Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to IMS_BP_Sample_ENV.

4 Right-click IMS_BP_Sample_ENV and select New IMS External System. Name 
the External System IMSExtSys. Click OK. IMSExtSys is added to the 
Environment Editor. 

5 Right-click IMS_BP_Sample_ENV and select New File External System. Name the 
External System FileExtSysInOut and Click OK. FileExtSysInOut is added to the 
Environment Editor. Modify both the Inbound and Outbound properties of the File 
eWay and click OK.

6 Right-click IMS_BP_Sample_ENV and select New Logical Host. The LogicalHost1 
box is added to the Environment and LogicalHost1 is added to the Environment 
Editor tree.

7 From the Environment Explorer tree, right-click LogicalHost1 and select Sun 
SeeBeyond Integration Server. A new Integration Server (IntegrationSvr1) is 
added to the Environment Explorer tree under LogicalHost1.

8 Save changes to the repository. The Environment Explorer and Environment Editor 
now appear as displayed in Figure 16.

Figure 16   Environment Editor

4.5.6 Configuring the eWays
The prjIMS_BP_Sample project uses three eWays, each represented in the Connectivity 
Map as a node between an External Application and a Business Process (see Figure 17). 
eWays facilitate communication and movement of data between the external 
applications and the eGate system. 
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Figure 17   eWays

The File eWay properties are configured from the Connectivity Map. The IMS eWay 
properties are set from both the Project Explorer’s Connectivity Map and the 
Environment Explorer. 

Note: For information on configuring the File eWay nodes, refer to the eWay File Adapter 
User’s Guide.

Configuring the IMS eWay

The IMS eWay properties must be set in both the Project Explorer and Environment 
Explorer. For more information on the IMS eWay properties and the Properties 
Window, see Configuring the eWay Properties on page 15 or see the eGate Integrator 
User’s Guide.

For the prjIMS_BP_Sample project, do the following:

Modifying the IMS eWay Connectivity Map Properties

1 From the Connectivity Map, double-click the IMS eWay. The Properties Window 
opens to the IMS eWay project configuration properties.

2 Modify the IMS eWay (Project Explorer) configuration for your system and click 
OK. For more information on these properties, refer to IMS eWay Connectivity 
Map Properties on page 20.

Modifying the IMS eWay Environment Explorer Properties

1 From the Environment Explorer tree, right-click the IMS External System 
(IMSExtSys in this sample), and select Properties from the shortcut menu. The 
Properties Window opens to the IMS eWay Environment Explorer properties.

2 Modify the IMS eWay Environment Explorer properties for your system and click 
OK. For more information on these properties, refer to IMS eWay Environment 
Explorer Properties on page 21.
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4.5.7 Creating the Deployment Profile
A Deployment Profile is used to assign services and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the prjIMS_BP_Sample 
Project and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample dpIMS_BPEL). Select 
IMS_BP_Sample_ENV as the Environment, insure the correct connectivity map is 
selected, and click OK.

3 From the Deployment Editor toolbar, click the Automap icon. The Project’s 
components are automatically mapped to their system windows, as seen in Figure 
18.

Figure 18   Deployment Profile - Auto Map

4.5.8 Creating and Starting the Domain
To build and deploy your Project, you must first create a domain. A domain is an 
instance of a Logical Host. After the domain is created, the Project is built and then 
deployed.

Note: You are only required to create a domain once when you install the Composite 
Application Platform Suite.

Steps required to create and start the domain:

1 Navigate to your <caps51>\logicalhost directory (where <caps51> is the location 
of your Sun Java Composite Application Platform Suite installation).

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.

4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
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an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

Note: For more information about creating and managing domains see the eGate 
Integrator System Administration Guide.

4.5.9 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon.

2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears.

2 A message appears when the project is successfully deployed. You can now test 
your sample.

4.5.10 Running the Sample Project
To run your deployed sample Project do the following

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data.
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Chapter 5

Implementing an IMS eWay Project

This chapter provides an introduction to the IMS eWay components and information on 
how these components are created and implemented in an eGate project. It is assumed 
that the reader understands the basics of creating a project using the Sun Enterprise 
Designer. For more information on creating an eGate project see the eGate Tutorial and 
the eGate Integrator User’s Guide.

What’s in This Chapter

IMS eWay Components on page 45

Importing a Sample Project on page 46

The prjIMS_JCD_Sample Project on page 47

The prjMFS_IMS_JCD_Sample Project on page 59

The prjMFS_JCD_Sample Project on page 69

5.1 IMS eWay Components
This chapter presents a sample IMS eWay project created using the same procedures as 
the sample end-to-end project provided in the eGate Integrator Tutorial. The eWay 
components that are unique to the IMS eWay include the following:

IMS eWay Configuration File

The properties file for the IMS eWay contains the parameters that are used to connect 
with a specific external system. These parameters are set using the Properties Window. 
For more information about the IMS eWay properties File and the Properties Window 
see Creating and Configuring the IMS eWay on page 15.

IMSClientETD OTD

The IMSClientETD OTD is provided with the eWay and contains methods and 
attributes that are used to create the Business Rules that invoke the IMS program. The 
nodes of the OTD take their initial value from the eWay Connection configuration 
parameters, but can be changed in the Collaboration.

IMS MFS Wizard

The IMS MFS Wizard builds an Object Type Definition from an IMS message format 
service (MFS) file. The wizard generates Object Type Definitions (OTDs) that map input 
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 45 Sun Microsystems, Inc.



Chapter 5 Section 5.2
Implementing an IMS eWay Project IMS eWay Sample Projects
and output message segments at the field level. The two sample projects that employ 
the IMS MFS Wizard are described in the following sections:

The MFS IMS JCD Project on page 61

The MFS JCD Project on page 71

5.2 IMS eWay Sample Projects
Three sample projects are described in this chapter to demonstrate how eWay 
components are created and implemented in a production environment. These sample 
eWay projects are included as part of the installation CD-ROM package.

The prjIMS_JCD_Sample Project on page 47, demonstrates connectivity with an 
IMS system. 

The prjMFS_IMS_JCD_Sample Project on page 59, demonstrates the IMS MFS 
Builder.

The prjMFS_JCD_Sample Project on page 69, demonstrates the use of the MFS 
OTD to compose IVTNO transaction messages.

5.3 Importing a Sample Project
To import a sample eWay project to the Enterprise Designer do the following:

1 The sample files are uploaded with the eWay’s documentation .sar file and 
downloaded from the Enterprise Manager’s Documentation tab. Extract the 
samples from the Enterprise Manager to a local file.

2 Save all unsaved work in Enterprise Designer before importing a sample project.

3 From the Enterprise Designer’s Project Explorer pane, right-click the Repository 
and select Import from the shortcut menu. The Import Manager appears.

4 Browse to the directory that contains the sample project zip file. Select the sample 
file and click Import. After the sample project is successfully imported, click Close. 

5 Before an imported sample project can be run you must do the following:

Create an Environment (see Creating an Environment on page 55)

Configure the eWays for your specific system (see Configure the eWays on 
page 56)

Create a Deployment Profile (see Creating the Deployment Profile on 
page 57)
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5.4 The prjIMS_JCD_Sample Project
The prjIMS_JCD_Sample project demonstrates connectivity with an external IMS 
system. 

Sample Project Overview

1 The inbound File eWay receives a file from an external directory. 

2 This file is the published by the IMS eWay to an external IMS application. 

3 The IMS eWay receives the file back from the external IMS application, and 
publishes the file to the outbound File eWay.

4 The outbound File eWay publishes the file to an external directory.

5.4.1 Create a Project
The first step is to create a new project in the eGate Enterprise Designer.

1 Start the Enterprise Designer.

2 From the Enterprise Explorer’s Project Explorer tab, select your Repository on the 
Project Explorer tree, right-click the Repository and select New Project (see Figure 
19). A new project (Project1) appears on the Project Explorer tree.

Figure 19   Enterprise Explorer - New Project

3 Click twice (not a double-click) on Project1 and rename the project (for this sample, 
prjIMS_JCD_Sample).
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5.4.2 Create a Connectivity Map
The Connectivity Map provides a canvas for assembling and configuring a project’s 
components.

1 In Enterprise Explorer’s Project Explorer, right-click the new project and select New 
> New Connectivity Map from the shortcut menu. 

2 The New Connectivity Map appears and a node for the Connectivity Map is added 
to the Project Explorer tree labeled CMap1. Rename the Connectivity Map 
cmIMS_JCD.

Select the External Applications

The icons on the Connectivity Map toolbar represent the available components used to 
populate the Connectivity Map canvas. 

When creating a Connectivity Map, the eWays are associated with external systems. For 
example, to establish a connection to IMS, you must first select IMS as an External 
Application to use in your Connectivity Map (see Figure 20). The IMS External 
Application icon is then added to the Connectivity Map toolbar.

Figure 20   Connectivity Map - External Applications

To add the External Applications used with the IMS_JCD_Sample project, do the 
following:

1 Click the External Application icon on the Connectivity Map toolbar.

2 Select the external systems that are necessary for your project (for this sample, IMS 
and File). Icons representing the selected external systems are added to the 
Connectivity Map toolbar.

Populate the Connectivity Map

Add the project components to the Connectivity Map by dragging the icons from the 
toolbar to the canvas. 

1 For this sample, drag the following components onto the Connectivity Map canvas 
as displayed in Figure 21: 

File External System (2)

Service (A Service is a container for Java Collaborations, Business Processes, eTL 
processes, and so forth.)

IMS External System
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Figure 21   Connectivity Map with Components

2 Rename the objects by right-clicking the object, selecting Rename from the shortcut 
menu, and typing in the new name. Change the names as follows:

File1 to eaFileIn

Service1 to jcolIMS

File2 to eaFileOut

IMS1 to eaIMS

3 Save your current changes to the Repository.

5.4.3 Creating the Collaboration Definitions
The next step in the sample is to create one Collaboration using the Collaboration 
Definition Wizard (Java). Once a Collaboration Definition has been created, the 
Business Rules of the Collaboration can be written using the Collaboration Editor 
(Java).

The IMS_Collab Collaboration (Java)

The jcdIMS Collaboration defines transactions from the inbound File eWay to the IMS 
eWay and from the IMS application to the outbound File eWay.

1 From the Project Explorer, right-click the prjIMS_JCD_Sample project and select 
New > Collaboration Definition (Java) from the shortcut menu. The Collaboration 
Definition Wizard (Java) appears.

2 Enter a Collaboration Definition name (for this project, jcdIMS) and click Next.

3 For Step 2 of the wizard, Select a Web Services Operation, Double-click Sun 
SeeBeyond> eWays > File > FileClient > receive. The File Name field now displays 
receive. Click Next.

4 For Step 3 of the wizard, from the Select OTDs to be used in this collaboration 
window, double-click Sun SeeBeyond> eWays > IMSeWay > IMS. The IMS OTD 
is added to the Selected OTDs field.
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5 Click the Up One Level button to return to the Repository. Double-click Sun 
SeeBeyond> eWays > File > FileClient. The FileClient OTD is added to the 
Selected OTDs field (see Figure 22).

Figure 22   Collaboration Definition Wizard (Java) - Select OTDs

6 Click Finish. The Collaboration Editor (Java) appears in the left pane of the 
Enterprise Designer and the jcdIMS Collaboration is added to the Project Explorer 
tree.

5.4.4 Using the Collaboration Editor (Java)
The next step in the sample is to create the Business Rules of the Collaborations using 
the Collaboration Editor. 

Creating the IMS_Java_Collab Collaboration

Be mindful to open all nodes specified in the directions, so all connections are made to 
the correct items. The jcdIMS Collaboration contains the Business Rule displayed in 
Figure 23. 
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Figure 23   IMS_Java_Collab Collaboration Business Rules

To create the jcdIMS Collaboration Collaboration Business Rules do the following:

1 From the Project Explorer tree, double-click the jcdIMS Collaboration to open the 
Collaboration Editor to the IMS_Java_Collab Collaboration.

2 To create comments for the Business Rules, from the Business Rules toolbar, click 
the Comment icon. The Create Comment dialog box appears. Enter the comment 
and click OK. The comment is placed on the Business Rules tree under the last 
selected item. Once the comment is created, it can be moved by clicking the 
comment and dragging it up or down the Business Rules tree to a new location.

3 Create the Copy input.Text to IMS_1.Message rule by mapping the Text node, to 
the Message node. To do this, click on Text (under Input in the left pane of the 
Business Rules Designer) and drag the cursor to the Message node (under IMS_1 in 
the right pane. See Figure 24).

Figure 24   Copy input.Text to IMS_1.Message Business Rule

4 To create the IMS_1.connect rule do the following:

A From the Business Rules toolbar click the Rule button to add a new rule. 

B Right-click the IMS_1 node in the left pane of the Business Rules Designer and 
select Select method to call from the shortcut menu. The method selection box 
appears. 
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C Select connect() from the method selection box. The connect method box 
appears in the Business Rules Designer canvas (see Figure 25 on page 52).

Figure 25   IMS_1.connect Business Rule

5 To create the IMS_1.IMSRequest Business Rule do the following:

A From the Business Rules toolbar click the rule button to add a new rule. 

B Right-click the IMS_1 node in the left pane of the Business Rules Designer, and 
select Select a method to call from the shortcut menu. The method selection box 
appears. 

C Select IMSRequest() from the method selection box. The IMSRequest method 
box appears in the Business Rules Designer canvas. 

6 To create the Copy IMS_1.Reply to FileClient_1.Text rule do the following:

A From the Business Rules toolbar click the rule button to add a new rule. 

B Right-click the IMS_1 node in the left pane of the Business Rules Designer, and 
select Select a method to call from the shortcut menu. The method selection box 
appears. 

C Select IMSReply() from the method selection box. The IMSReply method box 
appears in the Business Rules Designer canvas.

D Map the Result (String) output node of the IMSReply method box to Text, 
under FileClient_1 in the right pane of the Designer (see Figure 26). 
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Figure 26   Copy IMS_1.Reply to FileClient_1.Text Business Rule

7 To create the IMS__1.disconnect rule do the following:

A From the Business Rules toolbar click the rule button to add a new rule.

B Right-click IMS_1 in the left pane of the Business Rules Designer, and select 
Select a method to call from the shortcut menu. The method selection box 
appears. 

C Select disconnect() from the method selection box. The disconnect method box 
appears in the Business Rules Designer canvas.

8 To create the FileClient_1.write Business Rule do the following:

A From the Business Rules toolbar click the rule button to add a new rule.

B Right-click the FileClient_1 node in the left pane of the Business Rules Designer, 
and select Select a method to call from the shortcut menu. The method selection 
box appears.

C Select write() from the method selection menu. The write method box appears in 
the Business Rules Designer canvas (see Figure 27).

Figure 27   FileClient_1.write Business Rule

9 From the Collaboration Editor toolbar, click Validate to check the Collaboration for 
errors.

10 Save your current changes to the Repository.
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5.4.5 Creating Collaboration Bindings
After the Collaboration has been written, the components are associated and Bindings 
are created in the Connectivity Map.

1 From the Project Explorer tree, double-click cmIMS_JCD to display the 
Connectivity Map.

2 Drag and drop the IMS Java Collaboration (jcdIMS)from the Project Explorer tree to 
the IMS Service (jcolIMS). If the Collaboration is successfully associated, the 
Service icon’s “gears” change from red to green (see Figure 28).

Figure 28   Connectivity Map - Binding the Collaborations

3 Double-click jcolIMS in the Connectivity Map. The jcolIMS Binding dialog box 
appears.

4 From the jcolIMS Binding dialog box, map FileClient input (under Implemented 
Services) to the FileIn External Application, by clicking on input and dragging the 
cursor to the FileIn application.

5 From the jcolIMS Binding dialog box, map IMS IMS_1 (under Invoked Services) to 
the IMS External Application. 

6 From the jcolIMS Binding dialog box, map FileClient FileClient_1 to the File2 
External Application (see Figure 29).
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Figure 29   Connectivity Map - Connecting the Project’s Components

7 Minimize the IMS_Service dialog box, and save your current changes.

5.4.6 Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project, as well as containing the configuration information 
for these components. Environments are created using the Enterprise Designer’s 
Environment Explorer and Environment Editor.

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to IMS_JCD_Sample_Env.

4 Right-click IMS_JCD_Sample_Env and select New IMS External System. Name 
the External System IMSExtSys. IMSExtSys is added to the Environment Editor.

5 Right-click IMS_JCD_Sample_Env and select New File External System. Name 
the External System FileExtSysInOut and Click OK. FileExtSysInOut is added to 
the Environment Editor. Modify both the Inbound and Outbound properties of the 
File eWay and click OK. 

6 Right-click IMS_JCD_Sample_Env and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

7 From the Environment Explorere tree, right-click LogicalHost1 and select New > 
Sun SeeBeyond Integration Server from the shortcut menu. A new Integration 
Server (IntegrationSvr1) is added to the Environment Explorer tree under 
LogicalHost1 (see Figure 30).
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Figure 30   Environment Editor

8 Save your current changes to the Repository. 

5.4.7 Configure the eWays
The prjIMS_JCD_Sample project uses three eWays, each represented in the 
Connectivity Map as a node between an External Application and the Collaboration 
(see Figure 31). eWays facilitate communication and movement of data between the 
External Applications and the eGate system. 

Note: For information on configuring the File eWay nodes, refer to the eWay File Adapter 
User’s Guide.

Figure 31   eWays Nodes

Configuring the IMS eWay

The IMS eWay properties must be set in both the Project Explorer and Environment 
Explorer. For more information on the IMS eWay configuration properties and the 
Properties Window, see Creating and Configuring the IMS eWay on page 17, or refer 
to the eGate Integrator User’s Guide.

Modifying the IMS eWay Connectivity Map Properties

1 From the cmIMS_JCD Connectivity Map, double-click the IMS eWay. The 
Properties Window opens to the IMS eWay Project Explorer configuration 
properties.
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2 Modify the IMS eWay (Project Explorer) properties for your system and click OK. 
For more information on these properties, refer to IMS eWay Connectivity Map 
Properties on page 20.

3 Double-click the IMS eWay located between the jcolIMS service and the eaIMS 
External Application. Modify the IMS eWay configuration for your system and click 
OK.

Modifying the IMS eWay Environment Explorer Properties

1 From the Environment Explorer tree, right-click the IMS External System 
(IMSExtSys in this sample), and select Properties. The Properties Window opens to 
the IMS eWay environment-configuration properties.

2 Modify the IMS eWay environment-configuration for your system and click OK. 
For more information on these properties, refer to IMS eWay Environment 
Explorer Properties on page 21.

5.4.8 Configuring the Integration Server
You must set your SeeBeyond Integration Server Password property before deploying 
your Project. 

1 From the Environment Explorer, right-click IntegrationSvr1 under your Logical 
Host, and select Properties from the shortcut menu. The Integration Server 
Properties Editor appears.

2 Click the Password property field under SeeBeyond Integration Server 
Configuration. An ellipsis appears in the property field.

3 Click the ellipsis. The Password Settings dialog box appears. Enter STC as the 
Specific Value and as the Confirm Password, and click OK.

4 Click OK to accept the new property and close the Properties Editor.

For more information on deploying a Project see the Sun SeeBeyond Java™ Composite 
Application Platform Suite Deployment Guide.

5.4.9 Creating the Deployment Profile
A Deployment Profile is used to assign services and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the 
prjIMS_JCD_Sample Project and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample dpIMS_JCD). Select 
IMS_JCD_Sample_ENV as the Environment, insure the correct connectivity map is 
selected, and click OK.

3 From the Deployment Editor toolbar, click the Automap icon. The Project’s 
components are automatically mapped to their system windows, as seen in Figure 
32.
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Figure 32   Deployment Profile - Auto Map 

5.4.10 Creating and Starting the Domain
To build and deploy your Project, you must first create a domain. A domain is an 
instance of a Logical Host. After the domain is created, the Project is built and then 
deployed.

Note: You are only required to create a domain once when you install the Composite 
Application Platform Suite.

Steps required to create and start the domain:

1 Navigate to your <caps51>\logicalhost directory (where <caps51> is the location 
of your Sun Java Composite Application Platform Suite installation.

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.

4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

Note: For more information about creating and managing domains see the eGate 
Integrator System Administration Guide.

5.4.11 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon.
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2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears.

2 A message appears when the project is successfully deployed. You can now test 
your sample.

5.4.12 Running the Sample Project
To run your deployed sample Project do the following

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data.

5.5 The prjMFS_IMS_JCD_Sample Project 
The prjMFS_IMS_JCD_Sample project uses the MFS OTD to compose IVTNO 
transaction messages. 

1 An inbound File eWay supplies last names with which to create IVTNO "DISPLAY" 
transactions.

2 The MFS OTD is used to compose a transaction message for each supplied name, 
populating the OTD with the data and the transaction command "DISPLAY"

3 The OTD formats the message, which is passed through the IMS eWay to the IMS 
application.

4 The response is sent back to the MFS OTD, allowing field-by-field access to its 
content.

5 An outbound File eWay spools select portions of each transaction response to a flat 
file.

IMS Application Response Error Messages

The Java Collaboration in the prjMFS_IMS_JCD_Sample project includes a rule that 
causes each IMS application response to be logged as an error message in the 
Integration Server's log. This it is not an actual error, but is logged as such to display the 
response content as part of the demonstration without the need for the user to enable 
debug logging and contend with more extraneous messages.
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5.5.1 Create a project
The first step is to create and name a new project in eGate Enterprise Designer. 

1 From the Enterprise Explorer pane of the Enterprise Designer, right-click the 
Repository and select New Project. A new project appears on the Project Explorer 
tree.

2 Rename the project (for this sample, prjMFS_IMS_JCD_Sample). 

5.5.2 Create a Connectivity Map
1 In Enterprise Explorer, right-click the new project and select New > Connectivity 

Map from the shortcut menu. 

2 The new Connectivity Map appears. From the Project Explorer, rename the new 
Connectivity Map cmMFS_IMS_JCD.

Select the External Applications

To add the External Applications used with the MFS_IMS_JCD_Sample project, do the 
following:

1 Click the External Application icon on the Connectivity Map toolbar.

2 Select the File External Application from the selection menu. The File External 
System is added to the Connectivity Map toolbar.

Populate the Connectivity Map

Add the project components to the Connectivity Map by dragging and dropping the 
icons from the toolbar to the Connectivity Map canvas. 

1 For this project, add the following components to the Connectivity Map canvas as 
displayed in Figure 33: 

File External System (2)

Service (A Service is a container for Java Collaborations, Business Processes, eTL 
processes, and so forth.)

IMS External System
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Figure 33   Connectivity Map with Components

2 Save your current changes to the Repository.

5.5.3 Create an OTD Using the IMS MFS Wizard
The IMS MFS Wizard creates an OTD from an MFS data file. Sample MFS files, are 
provided with the IMS eWay sample, on the Installation CD-ROM. For this sample 
copy the dfsivf.mfs file to a temporary directory.

1 From the Project Explorer tree, right-click the prjMFS_IMS_JCD_Sample project 
and select New > Object Type Definition from the shortcut menu. The Object 
Type Definition Wizard appears.

2 From the Select Wizard Type box, select IMS MFS Wizard and click Next (see 
Figure 34).
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Figure 34   IMS MFS Wizard - Select Wizard Type

3 For step two of the wizard, Select Input Files, browse to the sample MFS file, 
dfsivf.mfs. Click Select to add the file to the Selected Files box (see Figure 35). 
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Figure 35   IMS MFS Wizard - Select MSF file

4 Click Finish and save your changes to the Repository. The OTD Editor now 
displays the successfully created dfsivf OTD and the OTD is added to the Project 
Explorer tree.

5.5.4 Create the Collaboration Definitions
The next step in the sample is to create a Collaboration using the Collaboration 
Definition Wizard (Java), and Business Rules using the Collaboration Editor.

The JavaCollaborationMFS Collaboration

The JavaCollaborationMFS Collaboration defines transactions from the inbound File 
application, converts the MFS data and sends the data to the outbound File application.

1 From the Project Explorer, right-click the current project and select New > 
Collaboration Definition (Java) from the shortcut menu. The Collaboration 
Definition Wizard appears.

2 Enter a Collaboration Definition name (for this project, jcdMFS_IMS) and click 
Next.
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3 For Step 2 of the wizard, Select a Web Services Operation, double-click Sun 
SeeBeyond > eWays > File > FileClient > receive. The File Name field now 
displays receive. Click Next.

4 For Step 3 of the wizard, from the Select OTDs selection window, double-click 
IMS_MFS_Sample > dfsivf1. The dfsivf1 OTD is added to the Selected OTDs field.

5 Click the Up One Level button to return to the Repository. From the Select OTDs 
selection window, double-click Sun SeeBeyond > eWays > File > FileClient. The 
FileClient OTD is added to the Selected OTDs field (see Figure 36).

Figure 36   Collaboration Definition Wizard (Java) - Select OTDs

6 Click Finish. The Collaboration Editor (Java) appears in the left pane of the 
Enterprise Designer and the jcdMFS_IMS Collaboration (Java) is added to the 
Project Explorer tree.

5.5.5 The MFS_IMS_Collab Business Rules
The the prjIMS_MFS_Sample project uses one Collaboration created in the previous 
section, jcdMFS_IMS. 

jcdMFS_IMS Business Rules

The jcdMFS_IMS Collaboration contains the Business Rules created using the 
Collaboration Editor.

String auditTransactStr;
String auditoTransactReply;
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StringBuffer outputBuffer = new StringBuffer();
dfsivf1_1.getIVTNOMI1().getIVTNOMI1_SEG1().setIVTNOMI1_SEG1_MFLD2_DEV
_CMD( "DISPLAY " );
dfsivf1_1.getIVTNOMI1().getIVTNOMI1_SEG1().setIVTNOMI1_SEG1_MFLD3_DEV
_NAME1( input.getText() );
auditTransactStr = dfsivf1_1.marshalToString();
IMS_1.setMessage( auditTransactStr );
IMS_1.connect();
IMS_1.IMSRequest();
auditoTransactReply = IMS_1.getReply().substring( 1, 
IMS_1.getReply().length() - 11 );
dfsivf1_1.unmarshalFromString( auditoTransactReply );
outputBuffer = outputBuffer.append( "FIRST NAME=" ).append( 
dfsivf1_1.getIVTNO().getIVTNO_SEG1().getIVTNO_SEG1_MFLD4_DEV_NAME2() 
);
outputBuffer = outputBuffer.append( "LAST NAME=" ).append( 
dfsivf1_1.getIVTNO().getIVTNO_SEG1().getIVTNO_SEG1_MFLD3_DEV_NAME1() 
);
outputBuffer = outputBuffer.append( "EXT #=" ).append( 
dfsivf1_1.getIVTNO().getIVTNO_SEG1().getIVTNO_SEG1_MFLD5_DEV_EXT_() 
);
outputBuffer = outputBuffer.append( "ZIP=" ).append( 
dfsivf1_1.getIVTNO().getIVTNO_SEG1().getIVTNO_SEG1_MFLD6_DEV_ZIP() );
FileClient_1.setText( outputBuffer.toString() );
IMS_1.disconnect();
FileClient_1.write();

For more information on how to create Business Rules using the Collaboration Editor 
see Using the Collaboration Editor (Java) on page 50 or refer to the eGate Integrator 
User’s Guide.

5.5.6 Creating Collaboration Bindings
After the Collaboration has been written, the components are associated and Bindings 
are created in the Connectivity Map.

1 From the Project Explorer tree, double-click cmMFS_IMS_JCD to display the 
Connectivity Map. 

2 Drag and drop the jcdMFS_IMS Collaboration from the Project Explorer onto the 
Service (Service1).

3 Double-click Service1 in the Connectivity Map. The Service1 Binding dialog box 
appears.

4 From the Service1 Binding dialog box, drag FileClient input (under Implemented 
Services) to the FileIn External Application.

5 From the Service1 Binding dialog box, drag FileClient_1 (under Invoked Services) 
to the FileOut External Application (see Figure 37 on page 66). 
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Figure 37   Connectivity Map - Connecting the Project’s Components

6 Minimize the Service1 Binding dialog box and save your current changes to the 
Repository.

5.5.7 Creating an Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project and contain the configuration information for these 
components. 

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to MFS_IMS_Sample_Env.

4 Right-click MFS_IMS_Sample_Env and select New File External System. Name 
the External System FileExtSysInOut and Click OK. FileExtSysInOut is added to 
the Environment Editor. Modify both the Inbound and Outbound properties of the 
File eWay and click OK.

5 Right-click MFS_IMS_Sample_Env and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

6 Right-click LogicalHost1 and select Sun SeeBeyond Integration Server from the 
shortcut menu. A new Integration Server (IntegrationSvr1) is added to the 
Environment Explorer tree under LogicalHost (see Figure 38). 
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Figure 38   Environment Editor

7 Save changes to the Repository. 

5.5.8 Configure the eWays
The IMS eWay properties must be set in both the Project Explorer and Environment 
Explorer. For more information on the IMS eWay configuration properties and the 
Properties Window, see Creating and Configuring the IMS eWay on page 15, or refer 
to the eGate Integrator User’s Guide.

Note: For information on configuring the File eWay nodes, refer to the eWay File Adapter 
User’s Guide.

Modifying the IMS eWay Connectivity Map Properties

1 From the cmMFS_IMS_JCD Connectivity Map, double-click the IMS eWay. The 
Properties Window opens to the IMS eWay Project Explorer configuration 
properties.

2 Modify the IMS eWay (Project Explorer) properties for your system and click OK. 
For more information on these properties, refer to IMS eWay Connectivity Map 
Properties on page 20.

3 Double-click the IMS eWay located between IMS_Service and the IMS1 External 
Application. Modify the IMS eWay configuration for your system and click OK. .

Modifying the IMS eWay Environment Explorer Properties

1 From the Environment Explorer tree, right-click the IMS External System 
(IMSExtSys in this sample), and select Properties. The Properties Window opens to 
the IMS eWay environment-configuration properties.

2 Modify the IMS eWay environment-configuration for your system and click OK. 
For more information on these properties, refer to IMS eWay Environment 
Explorer Properties on page 21.
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5.5.9 Creating the Deployment Profile
A Deployment Profile is used to assign services and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the 
prjMFS_IMS_JCD_Sample Project and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample dpMFS_IMS_JCD). Select 
MFS_IMS_JCD_Sample_ENV as the Environment, insure the correct connectivity 
map is selected, and click OK.

3 From the Deployment Editor toolbar, click the Automap icon. The Project’s 
components are automatically mapped to their system windows, as seen in Figure 
39.

Figure 39   Deployment Profile

4 Click Activate. When activation succeeds, save the changes to the Repository.

5.5.10 Creating and Starting the Domain
To build and deploy your Project, you must first create a domain. A domain is an 
instance of a Logical Host. After the domain is created, the Project is built and then 
deployed.

Note: You are only required to create a domain once when you install the Composite 
Application Platform Suite.

Steps required to create and start the domain:

1 Navigate to your <caps51>\logicalhost directory (where <caps51> is the location 
of your Sun Java Composite Application Platform Suite installation).

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.
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4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

Note: For more information about creating and managing domains see the eGate 
Integrator System Administration Guide.

5.5.11 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon.

2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears.

2 A message appears when the project is successfully deployed. You can now test 
your sample.

5.5.12 Running the Sample Project
To run your deployed sample Project do the following

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data.

5.6 The prjMFS_JCD_Sample Project 
The prjMFS_JCD_Sample project demonstrates the use of the IMS MFS builder to 
create an OTD from an MFS file and use it in a simple project.

1 Input data, formatted as content to an MFS message output control block, is 
subscribed to by the inbound File eWay from an external directory.

2 This data (message) is deserialized into an OTD generated from an MFS message 
specification. 
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3 The Collaboration demonstrates field-level data access to the message, concatenates 
and spools specific field values. The output produced by the Collaboration is the 
concatenation of all 8 message fields in the output control block, producing content 
identical to the input data.

4 The outbound receives the input data and publishes the message to an external 
directory.

5.6.1 Importing the prjMFS_JCD_Sample Project
To import the prjMFS_JCD_Sample project follow the directions from Importing a 
Sample Project on page 46, using the prjMFS_JCD_Sample.zip file. 

5.6.2 Create a project
The first step is to create and name a new project in eGate Enterprise Designer. 

1 From the Enterprise Explorer pane of the Enterprise Designer, right-click the 
Repository and select New Project. A new project appears on the Project Explorer 
tree.

2 Rename the project (for this sample, prjMFS_JCD_Sample). 

5.6.3 Create a Connectivity Map
1 In Enterprise Explorer, right-click the new project and select New > Connectivity 

Map from the shortcut menu. 

2 The new Connectivity Map appears. From the Project Explorer, rename the new 
Connectivity Map cmMFS_JCD.

Select the External Applications

For this sample project, only the File External Application is required.

1 Click the External Application icon on the Connectivity Map toolbar.

2 Select the File External Application from the selection menu. The File External 
System is added to the Connectivity Map toolbar.

Populate the Connectivity Map

Add the project components to the Connectivity Map by dragging and dropping the 
icons from the toolbar to the Connectivity Map canvas. 

1 For this project, add the following components to the Connectivity Map canvas as 
displayed in Figure 33: 

File External System (2)

Service
Sun SeeBeyond eWay™ Adapter for IMS User’s Guide 70 Sun Microsystems, Inc.



Chapter 5 Section 5.6
Implementing an IMS eWay Project The prjMFS_JCD_Sample Project
Figure 40   Connectivity Map with Components

2 Save your current changes to the Repository.

5.6.4 Creating an OTD Using the IMS MFS Wizard
The IMS MFS Wizard creates an OTD from an MFS data file. A sample MFS file, 
MFSSAMP.mfs is provided on the Installation CD-ROM with the IMS eWay sample at 
..\samples\ewims.. Copy this file to a temporary directory.

1 From the Project Explorer tree, right-click the prjMFS_JCD_Sample project and 
select New > Object Type Definition from the shortcut menu. The Object Type 
Definition Wizard appears.

2 From the Select Wizard Type box, select IMS MFS Wizard and click Next.
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Figure 41   IMS MFS Wizard - Select Wizard Type

3 For step two of the wizard, Select Input Files, browse to the sample MFS file, 
MFSSAMP.mfs. Click Select to add the file to the Selected Files box (see Figure 42). 
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Figure 42   IMS MFS Wizard - Select MSF file

4 Click Finish and save your changes to the Repository. The OTD Editor now 
displays the successfully created MFSSAMP OTD and the OTD is added to the 
Project Explorer tree.

5.6.5 Creating the Environment
Environments include the external systems, Logical Hosts, integration servers and 
message servers used by a project, as well as containing the configuration information 
for these components. 

1 From the Enterprise Designer’s Enterprise Explorer, click the Environment 
Explorer tab. 

2 Right-click the Repository and select New Environment. A new Environment is 
added to the Environment Explorer tree.

3 Rename the new Environment to MFS_JCD_Sample_Env.

4 Right-click MFS_JCD_Sample_Env and select New IMS External System. Name 
the External System IMSExtSys. IMSExtSys is added to the Environment Editor.

5 Right-click MFS_JCD_Sample_Env and select New File External System. Name 
the External System FileExtSysInOut and Click OK. FileExtSysInOut is added to 
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the Environment Editor. Modify both the Inbound and Outbound properties of the 
File eWay and click OK.

6 Right-click MFS_JCD_Sample_Env and select New Logical Host. The 
LogicalHost1 box is added to the Environment and LogicalHost1 is added to the 
Environment Editor tree.

7 Right-click LogicalHost1 and select Sun SeeBeyond Integration Server from the 
shortcut menu. A new Integration Server (IntegrationSvr1) is added to the 
Environment Explorer tree under LogicalHost.

5.6.6 Configure the eWays
The prjMFS_JCD_Sample project uses three eWays, each represented in the 
Connectivity Map as a node between an External Application and the Collaboration. 
eWays facilitate communication and movement of data between the External 
Applications and the eGate system. 

Note: For information on configuring the File eWay nodes, refer to the eWay File Adapter 
User’s Guide.

Modifying the IMS eWay Connectivity Map Properties

1 From the Connectivity Map, double-click the IMS eWay. The Properties Window 
opens to the IMS eWay project configuration properties.

2 Modify the IMS eWay (Project Explorer) configuration for your system and click 
OK. For more information on these properties, refer to IMS eWay Connectivity 
Map Properties on page 20.

Modifying the IMS eWay Environment Explorer Properties

1 From the Environment Explorer tree, right-click the IMS External System 
(IMSExtSys in this sample), and select Properties from the shortcut menu. The 
Properties Window opens to the IMS eWay Environment Explorer properties.

2 Modify the IMS eWay Environment Explorer properties for your system and click 
OK. For more information on these properties, refer to IMS eWay Environment 
Explorer Properties on page 21.

5.6.7 Creating the Deployment Profile
A Deployment Profile is used to assign services and message destinations to the 
integration server and message server. Deployment profiles are created using the 
Deployment Editor.

1 From the Enterprise Explorer’s Project Explorer, right-click the 
prjMFS_JCD_Sample Project and select New > Deployment Profile. 

2 Enter a name for the Deployment Profile (for this sample dpMFS_JCD_Sample). 
Select MFS_JCD_Sample_Env as the Environment, insure the correct connectivity 
map is selected, and click OK.
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3 From the Deployment Editor toolbar, click the Automap icon. The Project’s 
components are automatically mapped to their system windows.

4 Click Activate. When activation succeeds, save the changes to the Repository.

5.6.8 Creating and Starting the Domain
To build and deploy your Project, you must first create a domain. A domain is an 
instance of a Logical Host. After the domain is created, the Project is built and then 
deployed.

Note: You are only required to create a domain once when you install the Composite 
Application Platform Suite.

Steps required to create and start the domain:

1 Navigate to your <caps51>\logicalhost directory (where <caps51> is the location 
of your Sun Java Composite Application Platform Suite installation.

2 Double-click the domainmgr.bat file. The Domain Manager appears.

3 If you have already created a domain, select your domain in the Domain Manager 
and click the Start an Existing Domain button. Once your domain is started, a 
green check mark indicates that the domain is running.

4 If there are no existing domains, a dialog box indicates that you can create a domain 
now. Click Yes. The Create Domain dialog box appears.

5 Make any necessary changes to the Create Domain dialog box and click Create. The 
new domain is added to the Domain Manager. Select the domain and click the Start 
an Existing Domain button. Once your domain is started, a green check mark 
indicates that the domain is running.

Note: For more information about creating and managing domains see the eGate 
Integrator System Administration Guide.

5.6.9 Building and Deploying the Project
The Build process compiles and validates the Project’s Java files and creates the Project 
EAR file.

Build the Project

1 From the Deployment Editor toolbar, click the Build icon.

2 If there are any validation errors, a Validation Errors pane will appear at the bottom 
of the Deployment Editor and displays information regarding the errors. Make any 
necessary corrections and click Build again.

3 After the Build has succeeded you are ready to deploy your Project.

Deploy the Project

1 From the Deployment Editor toolbar, click the Deploy icon. Click Yes when the 
Deploy prompt appears.
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2 A message appears when the project is successfully deployed. You can now test 
your sample.

5.6.10 Running the Sample Project
To run your deployed sample Project do the following

1 From your configured input directory, paste (or rename) the sample input file to 
trigger the eWay.

2 From your output directory, verify the output data.
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